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ABSTRAKT 

Predmetom tejto diplomovej práce je klasifikácia mračien bodov z rôznych nosičov 

a s rôznou hustotou. Z dát bol ďalej vytvorený model terénu a modely budov. Popísané je aj 

softvérové vybavenie slúžiace na spracovanie dát. Predstavené sú dosiahnuté výstupy 

spracovania v každej príslušnej kapitole. Na záver je vykonané zhodnotenie a posúdenie 

výsledkov spracovania. 
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ABSTRACT 

This diploma thesis deals with the classification of the point clouds taken by different carrier 

and with various density. The terrain model and building models were created from provided 

data sets. Also the software equipment is described. Achieved outcomes of elaboration are 

presented in each corresponding chapter. In conclusion, the overall evaluation and 

assessment of the results of processing is done. 
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1 ÚVOD 

V posledných niekoľkých rokoch si môžeme všimnúť prudký rozmach zberu dát 

technológiou laserového skenovania, použitím rôznych nosičov. Táto technológia sľubuje 

širokú oblasť využitia a je cenená pre svoju presnosť, aktuálnosť a objem vytvorených dát. 

Cieľom práce je vytvoriť v prostredí programu TerraScan model terénu a modely budov 

a posúdiť kvalitu vytvoreného terénu a detekcie budov. Práca je rozvrhnutá do niekoľkých 

častí.  

Úvodná časť práce je venovaná stručnému historickému vývoju, súčasným trendom 

využitia dát a využívaniu dát v ČR, ako aj o možných výhľadoch použitia dát v budúcnosti. 

Zároveň podrobnejšie pojednáva o problematike laserového skenovania, o využívaných 

nosičoch a určovaných veličinách. Taktiež hovorí o technologickej stavbe laserových 

skenovacích systémov pre skenovanie letecké a mobilné. V neposlednom rade hovorí 

o použitom softvérovom vybavení pre spracovanie dát. 

Samotná praktická časť začína kapitolou piatou a zaoberá sa samotnému spracovaniu 

dát. A teda hovorí o metodike spracovania dát z leteckého a mobilného skenovania 

v rôznych typoch mestského územia mesta Brna v prostredí programov TerraScan.  

Kapitola šiesta sa venuje zhodnoteniu vytvorených modelov terénu a modelov budov, 

pričom popisuje samotnú metodiku vyhodnotenia a výsledky spracovania.  

Záverečná kapitola pojednáva o zhodnotení výsledkov tejto práce.  
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2 VÝVOJ A VYUŽITIE 

 História laserového skenovania 

Počiatky technológie laserového skenovania siahajú do roku 1960 [37], kedy T. 

Maiman zostrojil prvý funkčný laser. Praktické aplikácie však boli obmedzené na 

pozemné skenovanie, kedy nedochádzalo k pohybu laseru, a bolo teda možné určiť jeho 

polohu tradičnými geodetickými metódami. Prvou oblasťou, kde našiel laser praktické 

využitie, sa stala meteorológia [4]. Americké Národné Centrum pre Atmosférický 

Výskum (National Center for Atmospheric Research) využívalo laserové lúče na 

určovanie výšky oblačnosti. Časom sa začal využitím laseru zaoberať americký Národný 

Ústav pre Letectvo a Vesmír (NASA), ktorý technológiu laserovej altimetrie využil počas 

misie na Mesiac. 

S rýchlym rozvojom leteckej fotogrametrie, začali priemyselné spoločnosti 

vytvárať tlak na vývoj technológie, ktorá by umožňovala okamžité  priradenie súradníc 

skúmaných objektov súradniciam geografickým. Následne, spoločnosti zaoberajúce sa 

pozemnými navigačnými systémami začali s vývojom leteckých, resp. vesmírnych 

navigačných systémov. Spolu s družicami GPS vznikli aj presné inerciálne meracie 

systémy, obe zložky však boli spočiatku využívané iba pre vojenské účely [3].  

Po sprístupnení technológie GPS a IMU verejnosti, neexistovali prekážky na 

vytvorenie prvých funkčných leteckých skenerov a mobilných skenerov. V tom čase, boli 

laserové skenery schopné vyprodukovať 2 000-25 000 pulzov za sekundu (teda približne 

rovnaký počet bodov) [14], čo nebolo možné dosiahnuť s dovtedy využívanými 

metódami (klasické geodetické metódy, fotogrametria) v tak krátkom čase. Odborná 

verejnosť si teda začala uvedomovať potenciál laserového skenovania pre potreby 

mapovania.  

Dopyt po dátach vyhotovených laserovým skenovaním rýchlo rástol, no táto 

technológia narazila na obmedzenia v oblasti výpočtovej techniky, nakoľko  počítače ešte 

koncom 90. rokov 20. storočia neboli schopné efektívne spracovať obrovské objemy dát 

[14], ktoré laserové skenery produkovali. Táto situácia vyústila do rýchleho vývoja 

a vylepšenia počítačových systémov a GIS softvérov. 

S rýchlym rozvojom laserového skenovania a využívania dát takto vyhotovených, 

vznikla potreba po oficiálnych štandardoch a usmerneniach. Americká spoločnosť pre 

https://en.wikipedia.org/wiki/Lidar#cite_note-NOAA-1
https://en.wikipedia.org/wiki/Lidar#cite_note-NOAA-1
https://en.wikipedia.org/wiki/Lidar#cite_note-NOAA-1
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fotogrametriu a diaľkový prieskum, resp. ASPRS zaviedla ALS formát, ktorý sa rýchlo 

stal hlavným výstupným formátom laserových skenerov [14].  

 

  Súčasné využitie laserového skenovania 

Vzhľadom na rýchlosť a efektivitu produkcie mračien bodov pomocou laserového 

skenovania táto technológia našla využitie v mnohých vedných odboroch. V súčasnej 

dobe, keď skenovacie systémy dokážu vyprodukovať viac ako 250 000 pulzov za 

sekundu (napr skener LMS-Q680i od nemeckej firmy RIEGEL [21]), pracovať 

s násobnými odrazmi jednotlivých pulzov, alebo dokonca mapovať celý priebeh návratu 

pulzu sa zber dát prispôsobuje požiadavkám jednotlivých vedných odborov [14].  

Dáta leteckého laserového skenovania sú najčastejšie využívané pre rýchlu tvorbu 

digitálneho modelu terénu a povrchu (DMT, DMP), topografické mapovanie a 

kartografiu, archeológiu, urbanizmus, manažment a plánovanie lesného hospodárstva, 

skúmanie znečistenia ovzdušia, dopravné plánovanie [36]. 

Mobilné skenovacie systémy našli svoje uplatnenie v oblastiach ako sú 

topografické mapovanie, mapovanie a manažment cestnej siete, manažment podzemných 

vedení a ich údržba, simulácia pohybov, krízový manažment, rekonštrukcia budov, 

meteorológia, geológia (určovanie objemov) [36].  

 

 Budúci vývoj  

Čo sa týka budúceho vývoja technológie laserového skenovania (leteckého 

i mobilného), možno očakávať rozšírenie využitia do ďalších vedných oblastí. 

Napredovaním technologického vývoja čoraz citlivejších prístrojov možno očakávať 

zvýšenie presnosti a hustoty pokrytia povrchov bodmi. Priestor na zlepšenie technológie 

možno nájsť aj v oblasti odvodzovania povrchových vlastností skenovaných objektov 

vďaka analýze vráteného signálu. Hoci v súčasnosti neexistuje softvér dovoľujúci úplné 

automatické filtrovanie dát, je možné očakávať vývoj aj týmto smerom. To povedie ku 

komplexnejšiemu objektovému modelovaniu a automatizovanej extrakcii prvkov.  

Ďalšou, už existujúcou výhodou skenovacích systémov, ktoré poskytuje priestor na 

zlepšenie, je zlúčenie skenovania dát s digitálnym obrazom iného snímača (napríklad 
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multispektrálnymi kamerami) pre účely lepšieho rozpoznávania objektov. Ide 

o všeobecný trend smerom k univerzálnym multi-senzorovým systémom [1].  

Zaujímavou oblasťou, do ktorej prenikne laserové skenovanie (tento trend môžeme 

pozorovať už v súčasnosti), je použitie tzv. dronov a robotov pri získavaní dát, čo ešte vo 

väčšej miere zníži náklady na získavanie dát [13].  

 

 Využitie dát v ČR 

V súčasnej dobe, vzhľadom na ekonomickú náročnosť, je v Českej Republike 

niekoľko, najmä väčších firiem, ktoré dáta zabezpečujú s pomocou laserových 

skenovacích systémov (G4D [8], Geodezie Ledeč nad Sázavou [9], atď.). Ide najmä 

o aplikácie v rámci inžinierskej geodézie, napríklad mi zameriavaní skutočného stavu 

budov, neprístupných skalných celkov, zložitých technologických konštrukcií a zisťovaní 

objemu zemných prác. Uplatnenie našli aj pri dokumentácii priebehu výstavby alebo pri 

razení tunelov, kde umožňujú rýchlu kontrolu kvality diela. 

Situácia v oblasti leteckého laserového skenovania nachádza uplatnenie v súvislosti 

s mapovaním väčších geografických celkov. Ide napríklad (v prípade ČR) lesné a 

poľnohospodárske monitorovanie, mapovanie urbanizovaných zón, monitorovanie 

záplavových území. Všeobecne možno povedať, že najväčšie uplatnenie nachádza 

letecké skenovanie v oblasti tvorby digitálnych modelov terénu.  

V Českej republike je momentálne v rámci databázy ZABAGED® vytvorený nový 

výškopis, pre ktorého tvorbu boli využívané práve dáta získané metódou leteckého 

laserového skenovania ALS. Na tvorbe spolupracovalo ministerstvo zemědělství 

a ministerstvo obrany. Od roku 2009 (začiatok projektu) vzniklo niekoľko rád produktov 

(Tab. 1)  [40]. 
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Tab. 1: Modely terénu vytvorené z dát ALS  pre územie ČR, upravené z [40] 

 

 

Obr. 1:  Stav aktualizácie DMR 4G(Fialová-2009, Zelená – 2010, Modrá – 2011, Červená – 2013), 

upravené z  [26] 

 

Databáza 
Formát, 

Rozlíšenie 

Stredná 

chyba 

výšky (holý 

terén) 

Stredná chyba 

výšky 

(zalesnený 

terén) 

Stav 

aktualizácie 

(k 01/2016) 

Digitálny model 

reliéfu 4. Generácie  

(DMR 4G) 

Grid 5x5 m 0,3 m 1 m 
100 % 

(Obr. 1) 

Digitálny model 

reliéfu 5. Generácie  

(DMR 5G) 

TIN 0,18 m 0,3 m 
79 % 

(Obr. 2) 

Digitálny model 

povrchu 1. 

generácie (DMP 

1G) 

TIN 

Ohraničené 

objekty 0,4 

m 

Presne 

neohraničené 

objekty 0,7 m 

60% 

(Obr. 3) 
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Obr. 2:  Stav aktualizácie DMR 5G(Žltá – 2009, Fialová-2010, Zelená – 2011, Modrá – 2012, Červená – 

2013), upravené z [27] 

 

 

Obr. 3: Stav aktualizácie DMP 1G(Fialová-2009, Zelená – 2010, Modrá – 2011, Červená – 2013), 

upravené z  [28] 

Produkty sú vytvárané v súradnicovom systéme S-JTSK a vo výškovom systéme 

Balt po vyrovnaní (Bpv).  

Zber dát pre tvorbu týchto produktov je realizovaný laserovým skenerom RIEGL 

680. Ako technologické prostriedky využívané na spracovanie surových dát je využívaný 

súbor programov SCOP++ firmy INPHO, GmbH, pre filtrovanie dát a ich separáciu, ako 
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aj programy rady ArcGIS. Kompletné dokončenie tvorby týchto produktov je stanovené 

na koniec roka 2016 [29] [30] [31].  

Ďalším príkladom využitia leteckého laserového skenovania v ČR je projekt 

s názvom Využití dat leteckého laserového skenování na tocích a v příbřežních zónách, 

ktorý prebieha pod záštitou Výskumného ústavu vodohospodářskeho T.G. Masaryka 

(VÚV TGM). Zaoberá sa výskumom možnosti aktualizácie vodohospodárskych dát, resp. 

analýzou dát pre stanovenie záplavových území a možnosť identifikácie výškových 

prekážok na vodných tokoch. Výsledkom po testovaní vo vybraných lokalitách je záver, 

že letecké skenovanie je vhodné na identifikáciu tokov o šírke od 4 m a táto metóda (v 

kombinácii s iným výškopisnom zdrojom) je vhodná pre stanovenie záplavových území. 

Pre tvorbu máp povodňového nebezpečenstva a rizika je však DMT 5G vhodný ako zdroj 

výškopisu [38].  
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3 LASEROVÉ SKENOVANIE 

Laserové skenovanie (anglicky laserscanning), predstavuje spôsob, ako získať podrobné 

priestorové dáta o zemskom povrchu. Princípom fungovania laserového skenovania spočíva 

vo vyslaní zväzkov laserových lúčov, ktoré sa po odraze od objektov vrátia do skeneru.  

Vzhľadom na použité technológie, je laserové skenovanie jednou z najmodernejších, 

najefektívnejších, najrýchlejších a aplikačne najvariabilnejších technológií 

sprostredkujúcich možnosť získania geodetických dát. Výstupom laserového skenovania sú 

zvyčajne obrovské množstvá bodov (mračná), s určenými priestorovými súradnicami, 

pričom  následné spracovanie už prebieha s veľkou mierou automatizácie 

v špecializovaných softvéroch [16].  

 

 Rozdelenie podľa nosiča 

V súvislosti s laserovým skenovaním sa v súčasnej dobe najviac objavuje termín 

LiDAR (z anglického Light Detecting and Ranging), čo v slovenčine značí detekciu 

a meranie svetla. Podľa praktického využívania laserových skenerov sa zaužívalo 

rozdelenie na 3 hlavné oblasti.  

a) Letecké laserové skenovanie (Airborne Laser Scanning, ALS) – nosičom 

technológie skenera je letecký prostriedok, najčastejšie lietadlo, vrtuľník, 

sporadicky družice, ako napríklad ICEsat, a v poslednej dobe aj drony. 

Skener je doplnený ďalším technickým vybavením, zahŕňajúcim GNSS 

prijímač a inerciálnu jednotku [6] 

b) Mobilné laserové skenovanie (Mobile Laser Scanning, MLS) - v tomto 

prípade sa nosičom stáva pohybujúce sa vozidlo, napríklad automobil, 

loď, vlak. Zber dát je uskutočnený pozdĺž trasy po ktorej sa vozidlo 

pohybuje. Rovnako ako v prípade ALS, aj tu je nutná prítonosť GNSS 

prijímača a inerciálnej jednotky [17].  

c) Pozemné laserové skenovanie (Terrestrial Laser Scanning, TLS) – 

laserový skener je umiestnený na statíve, sú teda statické (vzhľadom 

k okoliu nemenia svoju pozíciu). Táto metóda nachádza uplatnenie 

napríklad v oblasti mapovania archeologických lokalít, či monitoringu 

malých oblastí [16]. 
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 Určované veličiny 

Vo všeobecnosti, laserové skenery merajú vzdialenosti a smery od osi prístroja 

k skenovanému objektu vo veľmi hustej matici, čím vzniká tzv. mračno bodov. Samotná 

vzdialenosť od vysielača určovaná dvoma nasledujúcimi metódami: 

- Meraním tranzitného času laserového lúča (resp. doby letu) – ide o meranie 

času vnútornými hodinami medzi vyslaním lúča a jeho opätovným prijatím 

po odrazení [6] 

- Porovnaním fázy lúča – vysielaný lúč je modulovaný harmonickou vlnou 

a vzdialenosť k predmetu od ktorého sa odrazí, sa vypočíta ako fázový 

rozdiel medzi vyslanou a prijatou vlnou  

Spolu s pozíciou bodov dokážu laserové skenery registrovať aj intenzitu energie 

odrazenej zo skenovaných objektov. Odrazivosť skenovaných povrchov je závislá na 

materiáli, štruktúre a farbe povrchov a vlnovej dĺžky laseru (príklady v Tab. 2). 

Vzhľadom na to, že po skenovaní sa informácie o intenzite odrazu prejavia priradením 

určitého stupňa šedi konkrétnym bodom, môže byť táto hodnota použitá na zlepšenie 

filtrácie, klasifikácie  a orientácie vo veľkých blokoch dát.  

Materiál Odrazivosť 

Biely papier až do 100 % 

Sneh 80 – 90 % 

Biele murivo 85 % 

Vápence, ílovce do 75 % 

Listnaté stromy 60 % 

Ihličnaté stromy 30 % 

Betónové povrchy 24 % 

Tab. 2: Odrazivosť niektorých materiálov [24] 

Laserové skenovanie patrí medzi neselektívne metódy merania, čo znamená, že na 

rozdiel od klasických geodetických metód nemeria charakteristické body skenovanej 

plochy, ale body sú rozmiesntené v pravidelnom uhlovom rastri (Obr. 4) 
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Obr. 4: Porovnanie získavania bodov pomocou geodetickej metódy a metódy skenovania [25] 

 

 Konštrukcia laserových skenovacích systémov 

Napriek tomu, že v oblasti laserového skenovania bolo v poslednej dobe vyrobené 

množstvo rôznych systémov, všetky majú rovnaký základ. GNSS prijímač, inerciálnu 

jednotku, laserovú a skenovaciu jednotku, notebook (Obr. 5), v prípade leteckých 

skenovacích systémov a v prípade mobilných skenovacích systémov je do zostavy 

pridaný aj odometer (Obr. 6). Parametre jednotlivých zložiek sa môžu vzhľadom na 

rozličných výrobcov môžu odlišovať. 

 

Obr. 5: Letecké skenovanie, upravené z [2] 
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Obr. 6: Mobilné skenovanie, upravené z [41] 

 

 Notebook  

Slúži ako prostriedok pre komunikáciu s kontrolnou jednotkou, pre 

nastavovanie parametrov alebo na monitorovanie systémov počas prieskumu [6]. 

 

 Laserová jednotka 

Laserová jednotka obsahuje laserový vysielač a prijímač. Na princípe 

fázového posunu fungujú lasery emitujúce nepretržitý lúč (continuous wave, CW). 

Prevažná väčšina skenerov však využíva pulzné lasery, v ktorých emitor vysiela 

krátke prerušované svetelné impulzy. Z času medzi vyslaním lúča a detekovaním 

jeho odrazu je vypočítaná vzdialenosť objektu.  

Veľkosť stopy emitovaného lúča je závislá na vzdialenosti od skenovaného 

objektu a od divergencie (rozbiehavosti) svetelného lúča. Zväzok sa na objekt 

nepremieta ako bod, ale kvôli atmosférickým vplyvom a rozbiehavosti sa rozdeľuje. 

Preto je možné merať niekoľkonásobný odraz jedného lúča. Ďalším druhom 

skenerov sú full-waveform skenery, ktoré zaznamenávajú priebeh celej krivky 

návratu signálu v časových intervaloch [6] [39]. 
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Väčšina komerčných systémov využíva laserové lúče s vlnovou dĺžkou 1000-

1500 nm (infračervené spektrum), v špeciálnych prípadoch (skenovanie vodných 

plôch) využíva modrozelenú časť spektra, kvôli lepšej priestupnosti.  

 

 Skenovacia jednotka 

Pre vychýlenie laserového lúča mimo svoju os je v skeneri zvyčajne 

umiestnené rotujúce zrkadielko, ktoré lúč vychýli v priečnom smere. V pozdĺžnom 

smere je vychýlenie zabezpečené vlastným pohybom nosiča (lietadlo, automobil). 

Celkový uhol záberu v priečnom smere definuje šírku záberu (zorné pole, resp. field 

of view).  

Podľa vzniknutého obrysu nameraných laserových dát rozlišujeme štyri typy 

skenerov: skenery s rotujúcim zrkadlom (Obr. 7a), s oscilujúcim zrkadlom (Obr. 7b), 

so zväzkom optických vlákien (Obr. 7c) alebo sústavou dvoch zrkadiel, resp. 

eliptický skener (Obr. 7d) [6].  

 

Obr. 7: Letecké skenovanie podľa typu skeneru, upravené z [6] 

 

 Inerciálna jednotka 

Vzhľadom na to, že pohybujúce sa lietadlo sa nepohybuje neustále v rovnakej 

výške, rovnakou rýchlosťou  a náklonom, bolo nutné určiť príslušné náklony 

a zrýchlenia. Na to slúži sústava gyrospokov a akcelerometrov. Sústava gyroskopov 
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dokáže určiť náklon celého systému vzhľadom k tiažnici. Akcelerometre naopak 

merajú zrýchlenie v rôznych smeroch. Porovnaním rozdielov zrýchlenia v čase je 

možné spätne určiť polohovú zložku pohybu nosiča [6].  

 

 GNSS prijímač 

Pre určenie presnej polohy senzoru sa používa sústava GNSS prijímačov 

umiestnených na palube lietadla. Minimom pre určenie polohy, je viditeľnosť na 

aspoň štyri satelity (GPS, GLONASS), no pre dosiahnutie vyššej presnosti je nutné 

vidieť aspoň 6 satelitov s využitím metódy DGPS (Diferenciálne GPS, Differential 

Global Positioning System). Táto metóda sa používa výberom jednej referenčnej 

stanice na známom bode a jednej stanice na palube nosiča [6].  

 

 Odometer 

Odometer, z gréckeho hodós (cesta)a métron (merať) je jednoduché 

zariadenie, pomocou ktorého je možné po kalibrácii určiť prejdenú vzdialenosť. Ide 

teda o vzdialenosť merací indikátor (angl. Distance Measuring Indicator DMI). 

Výstupom tohto zariadenia sú pulzy, ktoré sú vysielané po pootočení kolesa vozidla 

o určenú časť. Napríklad nastavenie 10 pulzov na meter znamená, že odometer vyšle 

pulz za každé pootočenie kolesa zodpovedajúce prejdeniu 10 cm vzdialenosti [12].  

 

 Výhody a nevýhody LS 

Ako už bolo spomenuté, medzi výhody laserových skenovacích systémov patrí 

vysoká rýchlosť zberu dát (rádovo tisícky bodov za sekundu), s čím priamo súvisí kratší 

pracovný čas v teréne a finančná úspora (v porovnaní s konvenčnými metódami merania. 

Keďže ide o bezkontaktnú metódu získavania dát, je možné zamerať aj ťažko prístupné 

a nebezpečné miesta v akýchkoľvek svetelných podmienkach. Za výhodu možno 

považovať aj skutočnosť, že súradnice zameraných bodov sú určované v reálnom čase 

(už behom merania, alebo bezprostredne po meraní). Presnosť získaných dát sa pohybuje 

v rozmedzí niekoľkých milimetrov, až po niekoľko centimetrov (v závislosti od 

použitého prístroja a typu merania). Automatický zber dát súvisí s ďalšou veľkou 
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výhodou, ktorou je kompletnosť získaných informácií (vysoká hustota bodov 

pokrývajúcich záujmovú lokalitu). Kompletnosť dát zároveň eliminuje potrebu ďalších 

návštev záujmovej lokality. Pri spracovaní dát sa uplatňuje vysoký stupeň automatizácie 

v špecializovaných softvéroch [15]. 

Popri mnohých výhodách laserového skenovania, majú tieto systémy aj nevýhody. 

Medzi tie patria napríklad vysoké vstupné náklady (skener). Vysoká hustota získaných 

bodov má za následok veľký objem spracovávaných dát, s čím súvisia vysoké nároky na 

hardware používaný pri spracovávaní dát. Napriek stupňu automatizácie spracovania dát 

je spracovanie mimoriadne časovo náročné (filtrácia, klasifikácia, vektorizácia...) [15].  
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4 SOFTVÉROVÉ VYBAVENIE 

Na spracovanie poskytnutých dát boli použité programy Bentley Microstation V8i 

(konkrétne nadstavby TerraScan a Terramodel). V neskoršej fáze spracovania bol použitý aj 

program ArcGIS 10.2.  Všeobecne možno spracovanie rozdeliť do niekoľkých krokov [15]:  

- Prípravné práce (rozdelenie, spájanie mračien) 

- Čistenie a redukcia dát (odstránenie príliš odľahlých bodov, bodov mimo 

záujmovej oblasti) 

- Klasifikácia (rozdelenie do tried podľa objektov) a Modelovanie 

- Vizualizácia (priradenie farieb, materiálov...) 

 

 TerraScan, TerraModeler  

Ide o nadstavbu pre program Bentley Microstation V8i od fínskej firmy Terrasolid 

Software, špecializujúcu sa na spracovanie dát z laserového skenovania. Možnosti 

programu dovoľujú spracovávať milióny bodov v rámci projektu.  

Nadstavba TerraScan  načíta body z textových súborov a tieto umožňuje zobraziť 

3D. Ďalej sa špecializuje na samotnú klasifikáciu (automatickú, manuálnu) bodov do 

tried, vektorizáciu budov, mapovanie elektrických vedení, komunikácií, železníc, 

vytváranie modelov terénu, atď. Samotný terén sa spracováva pomocou nástrojov 

nadstavby TerraModeler. V prostredí tejto nadstavby možno terén zobraziť, editovať, 

konvertovať do iných podôb (vrstevnicový model, tieňovaný model, trojuholníkový 

model...) [32].  

Podrobnejšie sú niektoré funkcie popísané v kapitole 5. 

 

 ArcGIS 10.2 

ArcGIS [7] je programom od americkej firmy ESRI, špecializujúci sa najmä na GIS 

aplikácie. Program je dodávaný v rôznych verziách, ktoré sa od seba líšia možnosťami 

spracovania dát. Základným modulom všetkých verzií je ArcMap, v ktorom sa zobrazujú 

a spracovávajú dáta spravované ArcCatalogom. Nástroje na spracovanie dát sú 

k dispozícii v rámci ArcToolboxu. Podrobnejšie sú použité nástroje rozpísané v kapitole 

5. 
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5 SPRACOVANIE DÁT 

V tejto kapitole podrobnejšie opíšeme spôsoby spracovania dát podľa [33] [35].   

 Územie mesta Brno a okolia 

Dáta z tohto územia boli zozbierané technológiou leteckého laserového skenovania, 

resp. ALS v súradnicovom systéme ETRS 89/UTM 33N prístrojom Riegl LMS-Q780 

[22] dňa 7.2. 2015. Ide o nalietaný pás, ktorý bol orezaný na obdĺžnikovú oblasť 

s rozmermi 3,6 x 25,2 km (Obr. 8).  

 

Obr. 8: Poloha riešeného územia, upravené z [19] 

Hustota pokrytia bodmi bola stanovená pomocou nástroja Measure point Density 

v programe TerraScan (obr. 9) a v priemere dosahovala hodnoty okolo 1,1 bodu na m2. 

Celkový počet nasnímaných bodov bol v tejto oblasti je 92 991 687 a bol určený 

nástrojom Show Statistics hlavného nástrojového okna TerraScan.  

 

Obr. 9: Nástroj Mesure point Density v okne View Laser v programe TerraScan [vlastné spracovanie] 
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 Príprava dát na spracovanie 

Po založení Microstation projektu načítame aplikáciu TerraScan. Vzhľadom 

na veľký objem spracovávaných dát bude nutné body rozdeliť do menších blokov. 

Pre tento účel kontrolne načítame body (Obr. 10), pričom pre urýchlenie procesu 

každý desiaty, a pomocou nástrojov kreslenia, ktorými program Microstation V8i 

disponuje, vykreslíme bloky s rozmermi približne 1,8 x 1,8 km (Obr. 11).  

 

Obr. 10: Načítanie bodov v prostredí TerraScan [vlastné spracovanie] 

 

Obr. 11: Rozvrhnutie blokov [vlastné spracovanie] 
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Ešte pred odpojením bodov je dobré (pre účely neskoršieho použitia) zistiť 

extrémne hodnoty Z súradnice bodov. Pre tento vytvoríme priečny rez bodmi, 

prostredníctvom možnosti v hlavnom okne, Draw Vertical Section a nakreslený rez 

zobrazíme v okne 2. Pre lepšie vyhodnotenie chybných bodov nastavíme pre Okno 

2 zobrazenie bodov podľa výšky postupom Point -> Display model (Obr. 12). 

 

 

 

 

 

 

 

 

 

 

 

Obr. 12: Postup vykreslenia rezu bodmi [vlastné spracovanie] 

V pohľade 2 (Obr. 13) dokážeme identifikovať očividne chybné body (pravý 

horný roh napr.). Zistíme hodnotu Z súradnice pre účely neskoršieho odfiltrovania 

z okna TerraScan, kliknutím na Identify a následným kliknutím na bod (Obr. 14). 

 

Obr. 13: Zobrazenie rezu bodmi  [vlastné spracovanie] 
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Obr. 14: Zobrazenie bodu s extrémnou súradnicou [vlastné spracovanie] 

Po vykonaní vizuálnej kontroly odľahlých bodov sme určili hraničné výšky 

pre neskoršiu filtráciu (233,5 m a 510,5 m). Po určení hraničných výškových hodnôt 

môžeme body odpojiť. 

Po odpojení bodov môžeme pristúpiť k ďalšiemu kroku, ktorým je založenie 

projektu pre TerraScan. Toto vykonáme prostredníctvom nástroja Define Project 

(Obr. 115), ktorý nájdeme v hlavnom nástrojovom okne.  

 

Obr. 15: Nástroj Define Project v okne General [vlastné spracovanie] 

Ešte pred načítaním bodov bude nutné nakreslené bloky uložiť 

v novozaloženom projekte. To vykonáme označením nakreslených blokov a v okne 

Project navrhneme tieto bloky pre projekt kliknutím na voľbu Add by boundaries 

(Obr. 16). V projekte následne pribudnú označené bloky. Predtým nakreslený návrh 

blokov je možné teraz vymazať a prekresliť ich z menu pre Project -> Draw 

boundaries. Následne projekt uložíme a potom môžeme pristúpiť k samotnému 

importu bodov do prekreslených blokov (Obr. 17). 

    

Obr. 16: Vytvorenie blokov [vlastné spracovanie] 
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Obr. 17: Import bodov do projektu [vlastné spracovanie] 

Po založení projektu a skonštruovaní blokov je možné pristúpiť k samotnej 

filtrácii a klasifikácii dát. 

  

 Filtrácia a klasifikácia dát 

 Filtrácia chybných bodov 

Prvým krokom po vytvorení projektu by malo byť odfiltrovanie 

bodov, ktoré sú očividne chybné. Otvoríme ľubovoľný blok kliknutím v rámci 

hraníc tohto bloku (Obr. 18).  

 

Obr. 18: Otvorenie bloku [vlastné spracovanie] 

Keďže sme si odčítali hraničné hodnoty už v predchádzajúcom kroku, 

môžeme body klasifikovať prostredníctvom rutiny (routine) postupom 

TerraScan -> Classify -> Routine -> Isolated points/By absolute elevation. 

Týmto spôsobom ale dôjde ku klasifikovaniu chybných bodov iba v aktuálne 
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otvorenom bloku bodov. Preto je výhodnejšie na prácu s bodmi vytvárať 

samostatné programy (MACRO), spôsobom TerraScan -> Tools -> Macro -

>File -> New. Pomocou voľby Add možno pridávať jednotlivé úkony 

a priradzovať im parametre. Vytvorené Macro potom možno otestovať na 

otvorenom bloku (prostredníctvom zapínania jednotlivých krokov programu 

kliknutím na Step). V tomto prípade je možné tento proces ešte zvrátiť. Je preto 

dobré otestovať čo možno najvhodnejšie parametre klasifikácie podľa 

záujmového územia (Obr. 19).  

 

 

Obr. 19: Vytvorenie Macro pre filtráciu odľahlých bodov [vlastné spracovanie] 

Vytvorené Macro potom možno aplikovať na celý projekt 

nasledovným postupom: v okne Project programu TerraScan klikneme na 

Tools -> Run Macro -> výber vytvoreného Macro programu -> nastavenie 

parametrov a výber blokov keďže program ponúka možnosť aplikácie na celý 

projekt, alebo len na značené bloky), na ktorých má byť proces vykonaný (Obr. 

20).  

Prostredníctvom vytvorených Macro programov boli vykonávané 

všetky automatické klasifikačné a filtračné práce v rámci tejto diplomovej 

práce. 
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Obr. 20: Spustenie Macro na vybraných blokoch projektu [vlastné spracovanie] 

 

  Klasifikácia terénu 

Vzhľadom na charakter popisovaného územia bude vhodné rozdeliť 

klasifikáciu na 2 časti (urbanizované a zalesnené územie, rovinaté územie) 

a pre tieto vytvoriť samostatné klasifikačné programy s rôznymi parametrami. 

Samozrejmosťou, rovnako ako v prípade filtrácie chybných bodov, je vhodné 

na zvolených blokoch otestovať rôzne parametre pre čo najlepšiu automatickú 

filtráciu (Obr. 21).  
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Obr. 21: Parametre Macro pre automatickú klasifikáciu vrstvy Ground v urbanizovaných 

a zalesnených oblastiach [vlastné spracovanie] 

 

Po klasifikovaní vrstvy terénu je vhodná vizuálna kontrola výstupu. 

Pre tento účel vytvoríme Editovateľný model terénu z vrstvy Ground. Na tento 

účel použijeme nástroj z ponuky Model tool box -> Create Editable Model. Po 

označení tejto položky dôjde k zapnutiu nadstavby TerraModeler. V menu 

vyberieme triedu, z ktorej chceme editovateľný model vytvoriť a následne 

dopíšeme názov modelu (Obr. 22).  
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Obr. 22: Vytvorenie editovateľného modelu terénu [vlastné spracovanie] 

Samotný model zobrazíme po kliknutí na možnosť Display Shaded Surface 

(Obr. 23) z hlavnej ponuky menu TerraModeler a výberom z množiny 

vytvorených modelov. Vo vytvorenom modeli je ľahšie vizuálne identifikovať 

chybne klasifikované miesta. V týchto miestach vykreslíme rez do iného okna 

(Obr. 25) a následne chybné body manuálne reklasifikujeme pomocou 

možností z ponuky Model Tool box hlavného menu TerraScan, ktoré okrem 

vytvorenia modelu ponúka možnosti manuálnej klasifikácie. Ide napr. o 

priradenie triedy jednotlivým bodom, klasifikácia pomocou štetca, klasifikácia 

v ohrade, atď. (Obr. 24).  

 

Obr. 23: Ponuka Display Surface z hlavného menu TerraModeler [vlastné spracovanie] 

 

Obr. 24: Model tool box z menu pre TerraScan umožňujúci manuálnu klasifikáciu [vlastné 

spracovanie] 

Veľkou pomôckou pri oprave chýb, je v sporných prípadoch 

pripojenie mapovej služby s fotografickými snímkami lokality 

prostredníctvom ponuky Raster Manager -> File -> Attach -> WMS programu 

Microstation.   
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Obr. 25: Príklad nesprávnej klasifikácie vrstvy Ground. Ide o budovu Galerie Vaňkovka 

[vlastné spracovanie] 

Po tom čo bola vykonaná vizuálna kontrola a oprava, je možné 

samotný model terénu vypnúť (ukladaný je automaticky, spolu 

s klasifikovanými bodmi).  

 

  Klasifikácia vodných telies 

Vzhľadom na to, že  v riešenej lokalite sa nachádza teleso Brnenskej 

vodnej nádrže, bolo by vhodné túto časť (Bloky 2, 4, 6, 8) reklasifikovať a body 

vodnej plochy odfiltrovať z vrstvy terénu (Obr. 27). Pre tento účel boli na 

podklade WMS digitalizované telesá vodných diel v samostatnej vrstve. 

Následne bolo vytvorené Macro, ktoré klasifikovalo len body ležiace vnútri 

týchto nakreslených polygónov (Obr. 26).  
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Obr. 26: Klasifikácia vodných plôch [vlastné spracovanie] 

  

Obr. 27: Príklad klasifikácie vodných plôch [vlastné spracovanie] 
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  Klasifikácia budov 

Podobne ako pre vrstvu Ground, boli vzhľadom na charakter zástavby 

definované 2 Macro postupy pre klasifikáciu budov v zalesnených 

a vidieckych územiach (Obr. 26) a pre urbanizované územia (Obr. 27) 

s rôznymi parametrami klasifikácie. Vytvorené Macro postupy tiež obsahujú 

kroky pre čiastočnú úpravu chybne klasifikovaných bodov pre budovy pre oba 

typy oblastí.  Po klasifikácii je opäť nutná vizuálna kontrola (Obr. 28) 

klasifikovaných oblastí a prípadná manuálna úprava.   

 

Obr. 28: Kroky Macro programu pre klasifikáciu budov v zalesnených a vidieckych 

oblastiach [vlastné spracovanie] 
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Obr. 29: Kroky Macro programu pre klasifikáciu budov v urbanizovaných oblastiach 

[vlastné spracovanie] 

 

Obr. 30: Príklad klasifikovanej oblasti Galeria Vaňkovka [vlastné spracovanie] 
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  Klasifikácia Vegetácie 

Podobne ako v predchádzajúcich prípadoch, vytvoríme Macro postup 

pre klasifikáciu vegetácie do troch tried. Nízkej (Low), Strednej (Medium) 

a Vysokej (High) vegetácie s určitými parametrami (Obr. 29) a následne 

vizuálne skontrolujeme (Obr. 30).  

    

 
Obr. 31: Parametre Macro pre klasifikáciu vegetácie [vlastné spracovanie] 

 

Obr. 32: Príklad klasifikácie vegetácie v oblasti Galerie Vaňkovka [vlastné spracovanie] 
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 Vizualizácia 

  Vizualizácia Terénu 

Pre účely vizualizácie terénu je vhodné (kvôli úspore pamäti) z vrstiev 

Ground a Water klasifikovať kľúčové body pre účely vytvorenia 

trouholníkového modelu terénu (Model keypoints). Pre tento účel bolo 

vytvorené Macro s určitými parametrami (Obr. 33). Body uložíme do 

samostatnej zložky (nie je nutné ich uložiť v rámci projektu).  

   

Obr. 33: Kroky Macro pre účely vytvorenia kľúčových bodov pre model terénu [vlastné 

spracovanie] 

Po klasifikovaní vrstvy Model keypoints založíme nový microstation 

projekt. Vytvorené súbory obsahujúce body vrstvy Model keypoints 

importujeme do prostredia programu Microstation ako Point Cloud (File -> 

Point Cloud, File -> Attach). Ešte ale nie je možné tieto body spracovať. Je 

nutné najprv jednotlivé mračná exportovať do iného formátu (Obr. 34).  

 

Obr. 34: Export mračna bodov [vlastné spracovanie] 

Následne môžeme mračno bodov odpojiť a možno pristúpiť 

k samotnému importu súradníc bodov. Toto vykonáme postupom: Tools -> 

Dimensions -> XYZ Text -> Import Coordinates. Po označení importovaných 
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bodov možno pristúpiť k samotnému vytvoreniu trojuholníkového modelu 

terénu prostredníctvom funkcie Mesh from Points (Obr. 35), ktorý už možno 

vizualizovať.  

 

 

Obr. 35: Tvorba terénu a vytvorený terén zobrazený ako sieťový model a ako vyhladený 

model [vlastné spracovanie] 

 

  Vizualizácia Budov 

Z predchádzajúceho kroku máme klasifikované body vo vrstve budov. 

Na ich vizualizáciu, je nutné tieto body zvektorizovať. Pre tento účel má 

prostredie programu TerraScan nástroj v hlavnom okne, pod položkou 

Buildings (Obr. 36). Týmto postupom sa budovy v aktívnom bloku 

zvektorizujú a priamo načítajú do projektu.   
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Obr. 36: Vektorizácia budov v aktívnom bloku [vlastné spracovanie] 

Vzhľadom na veľkosť riešeného územia je však vhodnejšie na 

vetorizáciu budov vytvoriť  Macro s určitými parametrami, a tým pádom 

spracovať celé územie (Obr. 37). Budovy zvektorizované týmto spôsobom boli 

uložené v osobitnom priečinku vo forme textového dokumentu.  

 

Obr. 37: Parametre vektorizácie pomocu Macro [vlastné spracovanie] 

Po skončení vektorizácie možno budovy z textových súborov načítať 

jednotlivo, podľa otvoreného bloku postupom Tools -> Read -> Building 

models. Môžeme priradiť farbu, prípadne materiál a možno vizualizovať (Obr. 

38).  Následne vizualizujeme budovy spolu s terénom (Obr. 39).  

   

Obr. 38: Zobrazenie vektorizovaných bodov ako sieťový model a ako vyhladený model 

[vlastné spracovanie] 
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Obr. 39: Spoločná vizualizácia terénu a budov [vlastné spracovanie] 

 

 Územie mestskej časti Líšeň 

Rovnako ako v predchádzajúcom prípade, boli dáta zbierané metódou leteckého 

skenovania v systéme ETRS 89/UTM 33N prístrojom Riegl LMS-Q780 [22] dňa 13.1. 

2015. Ide o pás s rozmermi 505 x 2250 m (Obr. 40). Hustota pokrytia bodmi bola 

nameraná nástrojom Measure point Density bola stanovená na priemernú hodnotu 12,5 

bodu na m2 a celkový počet bodov na tomto území je 13 662 601.  

 

Obr. 40: Poloha riešeného územia Brno Líšeň, upravené z [20] 
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 Príprava dát na spracovanie  

Podobne ako v prípade dát z lokality Brno, založíme nový Microstation 

projekt a načítamé aplikáciu TerraScan. Navrhneme blok, vytvoríme TerraScan 

projekt a body importujeme do vytvoreného projektu. Vzhľadom na rozmery územia 

postačí vytvorenie 1 bloku. Dôjde len k strate dát mimo hraníc navrhnutého bloku 

s rozmermi 505 x 2250 m. 

  

 Filtrácia a klasifikácia dát 

 Filtrácia chybných bodov 

Analogicky, rovnako ako v predchádzajúcej lokalite odfiltrujeme 

chybné body. Vzhľadom na odlišnosť lokality je ale nutné pozmeniť parametre 

filtrácie (Obr. 41).  

    

Obr. 41: Parametre pre filtráciu chybných bodov [vlastné spracovanie] 

 

  Klasifikácia terénu 

Terén bol klasifikovaný prostredníctvom programu Macro 

s pozmenenými parametrami (Obr. 42). Po klasifikácii bola opäť vykonaná 

vizuálna kontrola prostredníctvom vytvoreného editovateľného modelu terénu 

postupom známym z práce s predchádzajúcou lokalitou.  
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Obr. 42: Parametre klasifikácie vrstvy Ground v lokalite Líšeň [vlastné spracovanie] 

 

 Klasifikácia budov 

Klasifikačné postupy pre vytvorenie Macro vrstvy budov sú podobné 

ako v prvej riešenej lokalite (Obr. 43). Vytvorené Macro opäť obsahujú kroky 

pre malú korekciu klasifikovaných dát.  

     

 

Obr. 43: Parametre pre Macro na klasifikáciu budov [vlastné spracovanie] 
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Po klasifikácii opäť vykonáme vizuálnu kontrolu dát, pretože aj 

napriek nastaveným parametrom vznikli miesta s chybnou klasifikáciou. 

Chyby možno upraviť vytvorením programu pre opravu chýb (Obr. 44).  

   

Obr. 44: Parametre pre opravu klasifikácie budov [vlastné spracovanie] 

    

Obr. 45: Príklad opravy (pred opravou vľavo, po oprave vpravo) [vlastné spracovanie] 

 

 Klasifikácia vegetácie 

Vrstva vegetácie bola klasifikovaná s rovnakými parametrami ako 

v lokalite Brno, takže ju v tejto kapitole nebudeme ďalej rozvádzať.  

 

 Vizualizácie 

 Vizualizácia terénu 

Tvorba modelu pre vizualizáciu terénu prebieha rovnako ako 

v predchádzajúcom prípade, no keďže ide o menšiu oblasť a výpočtové 

možnosti hardvérového vybavenia to dovoľujú, vytvorený povrch sme potiahli 

fototextúrou povrchu. 
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Fototextúru sme získali prostredníctvom softvéru ArcMap 10.2 

z WMS služby, z ktorej sme pre riešenú oblasť exportovali georeferencovaný 

raster vo formáte .tif. Tento raster sme pripojili v programe Microstation 

pomocou ponuky Raster Manager. Aby bolo možné tento raster použiť ako 

textúru, je nutné o ňom zistiť informácie o rozmere a polohe počiatku rastra. 

Tieto informácie získame z okna Element information (Obr. 46). Po zistení 

potrebných informácií je možné raster odpojiť.  

 

Obr. 46 Inormačné okno rastra [vlastné spracovanie] 

Ďalším krokom je vytvorenie nového materiálu. V menu 

Visualization vyberieme možnosť Define Materials (Obr. 47). 

 

Obr. 47: Umiestnenie možnosti Define Materials v menu Visualization [vlastné spracovanie] 
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V okne dôjde k vytvoreniu novej palety materiálov (Obr. 48).  

 

Obr. 48: Nová paleta materiálov v okne material editor [vlastné spracovanie] 

V tejto palete vytvoríme nový materiál, ktorému priradíme raster 

a vyplníme parametre tohto rastra(Obr. 49).  

 

Obr. 49: Okno parametrov nového materiálu [vlastné spracovanie] 
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Po tom, čo máme vytvorený materiál, tento môžeme priradiť vrstve 

v ktorej sa nachádza vytvorený model terénu (Obr. 50).  

 

Obr. 50: Priradenie materiálu vrstve Terrain [vlastné spracovanie] 

Po vytvorení nového materiálu ktorý obsahuje fotografický obsah 

riešenej lokality, priradení tohto materiálu vrstve, ktorú reprezentuje, je 

možné terén vizualizovať (Obr. 49). 
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Obr. 51: Zobrazenie terénu a sieťový model a ako model s textúrou, upravené z [18], [vlastné 

spracovanie]  

 

 Vizualizácia budov 

Vizualizácia budov prebehla identickým postupom ako v prípade 

lokality Brno (Obr. 52).  

   

Obr. 52: Budovy zobrazené ako sieťové modely a ako vyhladené modely [vlastné spracovanie] 
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Obr. 53: Spoločné zobrazenie budov a terénu s fototextúrou,upravené z  [18], [vlastné 

spracovanie] 

 

 Lokalita Nový Lískovec 

V tomto prípade ide o lokalitu, ktorá bola nasnímaná oboma metódami. A teda 

leteckým skenovacím systémom a mobilným skenovacím systémom (Obr. 54).  

V prípade leteckého skenovania bola riešená oblasť s rozmerom 500 x 500 m. 

Hustota pokrytia bodmi je v priemere 11,5 bodu na m2 prístrojom Riegl LMS-Q780 [22]  

dňa 13.1.2015. Spôsob spracovania dát získaných leteckým skenovaním je rovnaký, ako 

v prípade lokality Líšeň (vzhľadom na obdobný charakter územia).  

Čo sa týka dát získaných metódou mobilného skenovania, tieto boli vytvorené 

16.7.2014 laserovým skenerom RIEGL VMX-450 [23]. Lokalita je rozdelená na  

nepravidelné bloky s celkovou rozlohou 6,48 ha. Hustota pokrytia bodmi je v porovnaní 

s leteckým skenovaním neporovnateľne vyššia a dosahuje priemerných hodnôt okolo 

1550  bodov na m2, čo ponúka širšie možnosti využitia (napríklad mapovanie elektrických 

vedení, mapovania povrchu ciest ciest...). 
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Obr. 54: Poloha riešeného územia (zelená-ALS, žltá - MLS), upravené z [20], [vlastné spracovanie] 

 

 Filtrácia a klasifikácia 

Vzhľadom na to, že máme v tejto oblasti dáta z oboch nosičov, budeme 

porovnávať výsledky jednotlivých krokov klasifikácie.  

 

 Klasifikácia terénu 

Dáta získané metódou ALS boli spracované rovnakým spôsobom, ako  

prípade lokality Líšeň (vzhľadom na podobnú hustotu bodov a štruktúru terénu).  

Čo sa týka bodov získaných metódou MLS bolo nutné zmeniť 

parametre klasifikácie terénu, no postupy zostali rovnaké. Avšak vzhľadom na 

rozdielnu metódu získania dát, vznikli mnohé „hluché“ miesta v klasifikácii. 

Z toho dôvodu oblasti za prekážkami neboli pokryté bodmi nevyhnutnými na 

vytvorenie kvalitného modelu terénu.   
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Obr. 55: Vytvorený model z dát ALS (vpravo) a MLS (vľavo) [vlastné spracovanie] 

 

 Klasifikácia budov 

Budovy pre súbor dát z ALS boli spracovávané rovnakým spôsobom 

ako pre súbor dát Líšeň.  

Súbor dát vytvorený metódou MLS si vyžadoval, čo sa týka 

klasifikácie budov, väčšiu mieru manuálnej práce, pretože program TerraScan 

vo veľkej miere pracuje s bodmi, ktoré dopadnú na strechy budov, pričom 

v tomto prípade ich ale bolo minimum (Obr. 56, Obr. 57). Je teda nutné 

detekovať steny budov (Obr. 58) a základe vypočítaných normálových vektorov, 

čím prebehne klasifikácia rovinných zvislých útvarov).  

    

Obr. 56: Klasifikované budovy zo súboru ALS [vlastné spracovanie] 
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Obr. 57: Klasifikované budovy zo súboru MLS [vlastné spracovanie] 

 

Obr. 58: Klasifikácia stien [vlastné spracovanie] 

 

 Klasifikácia vegetácie 

V klasifikácii vegetácie dochádza vzhľadom na veľkú podrobnosť 

bodov MLS k omnoho kvalitnejšej klasifikácii (vizuálne, počtom bodov) ako pri 

súbore dát vytvorených metódou ALS (Obr. 59, Obr. 60). V tomto prípade je 

teda vidieť možný potenciál v lesníctve.  

    

Obr. 59: Klasifikácia zelene z ALS dát [vlastné spracovanie] 
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Obr. 60: Klasifikácia zelene z MLS dát [vlastné spracovanie] 

 

 Vizualizácie  

Po rozklasifikovaní potrebných vrstiev vizualizujeme povrchy pre ALS 

a MLS (Obr. 61, Obr. 62). Ako už bolo spomenuté, v prípade MLS je jasne vidieť 

veľkých nepresností v zákrytoch pri vizualizácii terénu. Pri vizualizácii 

klasifikovaných budov sa ukazuje, že program TerraScan ešte nedokáže automaticky 

vytvoriť modely budov z dát MLS. Je teda nutné ich do veľkej miery manuálne 

upraviť.   

    

Obr. 61: Vizualizované budovy s terénom z dát AL, upravené z [18], [vlastné spracovanie] 

     
Obr. 62: Vizualizácie z dát MLS [vlastné spracovanie] 
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6 VYHODNOTENIE PRESNOSTI 

Pre účely vyhodnotenia presnosti vytvoreného terénu a presnosti rekognoskácie budov 

z dát laserového skenovania využijeme program ArcMap.  

Vytvorený terén budeme porovnávať s DMR 5G [5], ktorý vznikol tiež z dát laserového 

skenovania.  

Kritérium pre posúdenie presnosti identifikácie budov bude plocha detekovaná z dát 

laserového skenovania v porovnaní s údajmi z katastra a vizualizácia rozdielov plôch. 

 

 Vyhodnotenie terénu 

Vyhodnotenie terénu prebiehalo nasledovným spôsobom pre všetky 3 súbory dát. 

Z programu TerraScan boli uložené iba body klasifikované ako terén, ktoré boli načítané 

v programe ArcMap ako nový LasDataset prostredníctvom ponuky System toolbox -> 

Data Management Tools -> ALS Dataset -> Create ALS Dataset. Vytvorený súbor dát 

bol potom prevedený na TIN a ten potom na raster (Obr. 63) 

 

Obr. 63: ALS dataset prevedený na TIN a raster [vlastné spracovanie] 

Na vytvorenom rastri v pravidelnej mriežke vytvoríme body, ktorým vypočítame 

súradnice v systéme ETRS 89/UTM 33N a zároveň v súradnicovom systéme S-JTSK 

(Obr. 64). Po pripojení vrstvy DMR 5G, odčítame výškové hodnoty pomocou funkcie  
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Extract Multi Values to Points v rámci Spatial Analyst Tools pre oba rastre (nami 

vytvoreného z dát laserového skenovania, DMR 5G).  

 

Obr. 64: Mriežka 94 bodov v súbore dát Líšeň [vlastné spracovanie] 

Body následne vyexportujeme do programu Excel z programovej sady Microsoft 

Office. Keďže je výška určená na rastri vytvorenom z našich dát eliptická, v systéme 

ETRS 89/UTM 33N, je nutné aplikovať transformáciu pre zistenie výšky v systéme Bpv. 

Pre tento účel použijeme jednu z dostupných online transformačných služieb [37].  

Po tom, čo máme určené výšky v rovnakom výškovom systéme, môžeme pristúpiť 

k rátaniu odchýlok a určeniu základných charakteristík ktorými sú: 

- Maximálna odchýlka: vyjadruje najvyššiu odľahlosť vytvoreného 

modelu od DMR 5G  

- Minimálna odchýlka: hodnota najmenšej odľahlosti vytvoreného modelu 

od DMR 5G  

- Stredná hodnota odchýlky: dosiahnutá stredná odchýlka vypočítaná ako 

priemer odchýlok bodov vytvoreného modelu od DMT 5G [11] 

- Smerodajná odchýlka: vypočítaná ako odmocnina zo sumy podielu 

odchýlok a počtu meraní [11] 

- Celková presnosť: vypočítaná ako odmocnina kvadrátov presnosti DMR 

5G (0,3 m), presnosti transformácie (0,05 m), presnosti skeneru (udávané 

výrobcom) a presnosti pohybu nosiča, určuje presnosť vytvoreného 

terénu vzhľadom k jeho reálnemu priebehu  

Následne zostrojíme histogram odchýlok, ktorý by mal spĺňať normálne rozdelenie 

hodnôt (Graf 1), (Graf 2), (Graf 3), (Graf 4) [11].  

V tabuľke sú uvedené základné charakteristiky presnosti bodov vytvoreného terénu 

(Tab. 3). 
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Lokalita 

Brno Líšeň 
Nový Lískovec 

(ALS) 

Nový Lískovec (MLS) 

Zahrnuté 

všetky body 

Po vylúčení bodov 

mimo ciest 

Počet bodov 179 94 81 44 37 

;Maximálna 

odchýlka (cm) 
350,1 277,3 305,7 198,4 0,34 

Minimálna 

odchýlka (cm) 
0,4 0 0,1 0,2 0,2 

Stredná 

hodnota 

odchýlky (cm) 

17,4 -6,01 -0,94 16,23 7,73 

Smerodajná 

odchýlka (cm) 
39,192 38,09 39,38 50,48 11,2 

Počet bodov 

mimo intervalu 

˂-2σ, +2σ˃ 

4 4 2 4 2 

Výsledná 

presnosť m 

(cm) 

32 32 32 30,8 30,8 

Presnosť DMR 

5G (cm) 
30 30 30 30 30 

Tab.  3: Tabuľka hodnôt charakteristík presnosti jednotlivých súborov dát [vlastné spracovanie] 

 

 
Graf 1: Histogram odchýlok terénu zo súboru dát Brno 
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Graf 2: Histogram odchýlok terénu zo súboru dát Líšeň 

 
Graf 3: Histogram odchýlok terénu zo súboru dát Lískovec_ALS 

 
Graf 4: Histogram odchýlok terénu zo súboru dát  Lískovec_MLS 

Z porovnania vychádza, že modely vytvorené z poskytnutých dát sú čo sa 

týka kvality porovnateľné s DMR 5G vzhľadom k reálnemu terénu. Ďalej je zrejmé, 

že vytvorený terén obsahuje miesta s extrémnymi odchýlkami. To sa dá vysvetliť 

stavebnými prácami v týchto miestach, ako aj možnou nepresnosťou, resp. 

neaktuálnosťou dát. 

V prípade terénu vytvoreného z dát MLS možno uvažovať o použití iba 

v rámci bezprostredného okolia cestnej siete, pretože v zákrytoch objektov nie je 

dostatočné množstvo bodov na vytvorenie presnejšieho modelu.  
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 Vyhodnotenie budov 

Ako bolo spomenuté, hlavným kritériom pri porovnávaní presnosti detekcie budov 

bude kritérium rozlohy a vizuálne kritérium, keďže mohlo dôjsť k identifikácii 

objektu ako budovy v prípade vyhodnotenia dát, ale v prípade katastrálnej mapy tam 

táto nie je (a naopak).  

Na vyhodnotenie pomocou rozlohy potrebujeme orezať výber z RÚIAN-u podľa 

riešeného územia a zároveň mať vytvorenú vrstvu polygónov predstavujúcich pôdorys 

detekovaných budov zo spracovávaných dát.  

Zvektorizované budovy importujeme do prostredia programu ArcMap ako novú 

vrstvu Polyline. Tú následne prevedieme do polygónov pomocou nástroja Feature to 

Polygon, vytvoríme z jednotlivých budov spojené bloky a následne spočítame úplnú 

výmeru všetkých identifikovaných budov (rovnako pre vrstvu z KN). Na vizuálnu 

interpretáciu použijeme nástroj Symmetrical difference  a voľbou vhodnej symbológie 

interpetujeme rozdiely v detekcii budov (Obr. 65)  

 

Obr. 65: Budovy detekované z dát ALS, budovy z KN, rozdiel plôch [vlastné spracovanie] 

Následne určíme charakteristiky z vypočítaných výmer (Tab. 4). Medzi tieto patria 

[10]: 

- Detekovaná oblasť (DO): ide o územie detekované z dát laserového 

skenovania 
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- Referenčná oblasť (RO): územie vymedzené z podkladov KN 

- Totožné: prienik DO a RO (správne určená oblasť) 

- Zjednotenie: zjednotenie plôch DO a RO 

- Kvalita detekcie: pomer medzi správne detekovanými oblasťami a plochami 

zjednotenými 

- Úplnosť detekcie: vyjadruje pomer medzi správne určenou oblasťou 

(prekrytie) a DO 

- Správnosť detekcie: vyjadruje mieru správnosti detekcie plôch budov. 

Hodnota je určená ako pomer správne detekovaného (Totožné) a DO 

 

Lokalita 

Brno Líšeň 
Nový Lískovec 

(ALS) 

Nový Lískovec 

(MLS) 

Detekovaná 

oblasť (m2) 
7242824 145822 39655 10360 

Referenčná 

oblasť (m2) 
9958906 167919 38082 10766 

Totožné  (m2) 6223482 128475 33933 9647 

Zjednotenie 

(m2) 
10973247 185265 43793 11479 

Kvalita 

detekcie (%) 
56,72 69,35 77,48 84,04 

Úplnosť 

detekcie (%) 
62,49 76,51 89,11 89,61 

Správnosť 

deteckie (%) 
85,93 88,1 85,57 93,12 

Tab.  4: Vyhodnotenie detekcie budov [vlastné spracovanie] 
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7 ZÁVER 

Cieľom diplomovej práce bolo posúdenie rôznych dát laserového skenovania 

z leteckého a mobilného nosiča, pričom tie boli zadovážené s rôznou hustotou pokrytia 

bodmi, pre účely tvorby terénu a vektorizácie budov. 

Ako vstup boli použité dáta zadovážené v roku 2014 (MLS) a 2015 (ALS) laserovými 

skenermi centra AdMaS v rôznych častiach mesta Brna a rôzne podklady z databázy ČUZK 

vo forme mapových služieb.  

Pri posudzovaní kvality vytvoreného terénu je nutné brať ohľad na časové zmeny 

v riešených lokalitách. Extrémne odchýlky, ktoré sa objavili v súbore spracovávaných 

bodov, môžu mať viacero príčin. Či už sú to možné stavebné úpravy v miestach extrémnych 

odchýlok, alebo časovým nesúladom dát, až po možnú nepresnosť oficiálneho vytvoreného 

digitálneho modelu terénu.  

Lokality, pri ktorých boli spracovávané ALS dáta, vykazujú porovnateľnú úroveň 

presnosti vytvoreného terénu vzhľadom na reálny terén ako model DMR 5G. 

Terénny model vytvorený z dát MLS, po nezapočítaní bodov v zákrytoch, dosahuje 

výrazne vyššej presnosti vzhľadom k DMR 5G (nie je ale ďalej možné hovoriť 

o komplexnom modeli terénu, nakoľko sa model obmedzí len na bezprostredné okolie 

cestnej siete), no vzhľadom k reálnemu terénu je na tom kvalitatívne podobne.  

Čo sa týka vektorizácie budov, je vo vyhodnotení vidieť veľké odchýlky od stavu 

uvedeného v katastri nehnuteľností.  

Pri lokalite Brno, je možné si všimnúť, že bolo úplne správne detekované nižšie 

percento, ako v prípade ostatných lokalít. To je možné vysvetliť najmä hustotou skenovania 

(množstvo menších budov nebolo detekovaných, z dôvodu malého počtu bodov; neúplnosť 

detekovaných striech a nedokonalosti automatickej vektorizácie). 

V ostatných lokalitách je vidieť podstatné zvýšenie úplnosti detekcie budov. Vzhľadom 

na to, že ALS dáta pre Líšeň a Nový Lískovec boli zbierané s podobonou husotou, dalo sa 

predpokladať, že aj výsledky detekcie budú dosahovať podobné. No pri úplnosti detekcie si 

môžeme všimnúť výrazné odchýlky. Tie je ale možné vysvetliť charakterom zástavby 

v týchto lokalitách. V prípade Nového Lískovca ide o zväčša o budovy pravidelných tvarov 

(bytové domy), pri ktorých je jednoduchšia ich detekcia v mračne bodov. Naopak, v prípade 

lokality Líšeň, tvoria veľkú časť rodinné domy v radovej zástavbe, prevažne so sedlovými 

a inými strechami (nepravidelných tvarov), ktorých automatická detekcia je obtiažnejšia. 



 Klasifikace mračen bodů  z leteckého a mobilního skenování– Diplomová práca 
_______________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________ 

Ján Borový 

 

61 

 

Ako najpresnejšie a najúplnejšie sa teda javia dáta z MLS pre lokalitu Nový Lískovec. Na 

druhej strane je ale nutné zdôrazniť, že práve táto metóda vyžaduje nepomerne viac času pri 

vektorizácii budov.  

Napriek lokálnym nepresnostiam ale nemožno dátam získaným laserovým skenovaním 

uprieť do budúcnosti veľký potenciál. V prípade tejto práce, by bolo možné dosiahnuť 

lepších výsledkov, ak by sa procesy vykonávali s väčším prispením manuálneho 

spracovania, čo môže byť podnetom pre ďalšie spracovanie.  

Čo sa týka samotného spracovania dát z laserového skenovania vo všeobecnosti, možno 

časom očakávať výraznejší posun ku kvalite vytvorených produktov prostredníctvom 

automatickej klasifikácie, vektorizácie a ďalších procesov súvisiacich so spracovaním 

týchto dát.  
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ALS Lidarový archívny štandard(Lidar Archive Standard) 
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DMP Digitálny Model Povrchu 
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ALS Letecké laserové skenovanie (Aerial Laser Scanning) 
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